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Introduction

About this Guide

The RocketRAID 1740 SATAII Host Adapter’s User’s Guide provides information
about the functions and capabilities of the host adapter, and instructions for
installing, configuring and maintaining RAID arrays hosted by the adapter.

Introducing the RocketRAID 1740 Host Adapter

The HighPoint RocketRAID 1740 is a 4-channel PCI to Serial ATA II RAID controller.
The RocketRAID 1740 solution is ideal for small business servers, NAS storage,
workgroup and web servers, video streaming / video editing workstations, back up, and
security systems.

Product Features

e  PCI32bit@33/66 MHz

e 4 SATATI 3Gb/s ports

e Upto4 SATAII or SATA I Hard Drives

e SupportRAIDO0, 1,5, 10, and JBOD

e Backward compatible with RocketRAID 1640 RAID arrays

e Native Command Queuing (NCQ)

e Online Capacity Expansion (OCE) and Online RAID Level Migration (ORLM)
e Staggered drive spin up

e Hard Disk (Activity / Failed) LED chassis function

e  SAF-TE Enclosure Management Functions

e BIOS Booting (INT13) to RAID array

e Quick and Background initialization for instant RAID access

e Write through and write back cache for RAID arrays

e  Hot swap and hot spare

e Online array roaming

e Automatic detect drive to rebuild degraded RAID

e S.M.AR.T array monitoring for hard drive status and reliability
e  64-bit LBA for RAID arrays greater than 2TB

e  Low profile form factor for 1U chassis
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e  Web browser-base software (Web GUI)

e Command Line Interface (CLI)

e  SMTP email notification for events and error reporting

e Remote array management through (Web GUI, RAID GUI and CLI)
e  Support Windows (XP, 2000, Server 2003), Linux and FreeBSD

e RoHS Compliant

Understanding RAID Concepts and Terminology

The following concepts and terminology is commonly used when describing the
functions of the RocketRAID 1740 Host Adapter.

Disk initialization

Initializing a disk writes necessary RAID configuration information to that disk. Disks
must be initialized before configuring them into RAID arrays. The initialization

process will destroy all data on the disk.

Disk Status

New The disk contains no data and has not been initialized.
Initialized The disk has been initialized and can be used for array creation.

Configured  The disk has been assigned to one or more arrays, or configured as a

spare disk.

Legacy The disk was used on other controllers before use with the
RocketRAID 1740 (see legacy disk below).

Array initialization

A redundant array (RAID 5, RAID 1, RAID 10) needs to be initialized to ensure full
performance and reliability. Non-redundant arrays (RAID 0, JBOD) do not need to be
initialized.

When you create a redundant array using the RocketRAID 1740 controller’s BIOS
Configuration Utility, it will create the array in un-initialized state. The initialization

process can be completed after installing the driver and management software.

1-2 —
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When creating an array using the HighPoint RAID Management Console software,
you can specify an initialization option (Skip initialization, foreground and

background).

Foreground initialization

Foreground initialization will zero-out all data on the array. The array is not accessible

by the operating system until initialization is complete.

Background initialization

Background initialization allows the array to be used immediately. For RAID1 and
RAIDI10 arrays, initialization will results in data being duplicated identically to the
mirror pair. For RAIDS arrays, initialization will result in parity being generated from

all array members.

Note: An un-initialized RAID1 or RAID10 array can still provide redundancy in case
of a disk failure. A RAIDS array, however, is not fault-tolerant until initialization is
finished.

Online Capacity Expansion (OCE)

This feature allows disks to be added to existing RAID arrays, in order to increase the
array’s capacity, without fear of data loss. Any number of disks can be added to an

array, at any time. Data can be accessed and utilized even while being redistributed.

Online RAID Level Migration

This term describes the ability to change one type of array (RAID level), into a
different type of array (changing a RAID 1 array into a RAID 10 array for example).
Data is still accessible during the migration process, and a base level of security is

still active.
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OCE, ORLM and the RocketRAID 1740

The RocketRAID 1740 supports both Online Capacity Expansion (OCE), and Online
RAID Level Migration (ORLM). Both features are supported by a single function - an
array can be transformed from one RAID level to another RAID level while simulta-

neously being resized, even under I/O load.

Spare disk

A spare disk is a single disk that can be used to automatically rebuild a redundant
array in case of drive failure. Spare disks may also be members of a RAID array. Any

available space on these disks may be used to rebuild other broken arrays.

Legacy disk

Disks attached to the RocketRAID 1740 that contain valid partition tables will be
identified as legacy disks. A legacy disk attached to the RocketRAID 1740 can be
accessed by the operating system, but cannot be used to create RAID arrays. A

legacy disk must be initialized before assigning it to an array.
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RocketRAID 1740 Hardware
1 - RocketRAID 1740 Adapter Layout

Portl - Port4

These represent the RocketRAID 1740’s four SATAII channels. The SATA port
furthest away from the surface of the adapter is always the odd numbered channel (1,
3), while the port closest to the adapter is the even numbered channel (2, 4,).

CONN1, CONN3

These LED connectors can be used to configure Disk Failure (CONN3) and Disk
Activity (CONNI) indicators for each individual disk attached to the RocketRAID
1740.

BEEP1 - Speaker

Alarm (speaker): The speaker emits and audible alarm in the case of disk/array failure.

JPS
SAF-TE support: this support is dependent upon the system chassis. Not all chassis

models support SAF-TE features. Consult the chassis’s manual for more information.
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2 - LED Connections

The RocketRAID 1740 has two LED jumpers that are used to indicate the activity and
failure status of hard disks attached to the card’s four SATAII channels. These jumpers
are labeled as CONN# (connector).

The odd numbered pins of each CONN (1, 3, 5, and 7) represent the RocketRAID
1740’s SATA channels 1, 2, 3, and 4 respectively. The even numbered pins (top row)

are not utilized.

CONNI1 - Hard disk Activity LED’s.

CONN?3 - Hard Disk Failure LED’s.

3 - Installing the RocketRAID 1740 Host Adapter

Note: Make sure the system is powered-off before installing the RocketRAID 1740
host adapter.

The RocketRAID 1740 includes both standard and low-profile brackets. It may be
necessary to attach the low-profile bracket in place of the standard bracket, depend-

ing upon the chassis design.

1. Open the system chassis and locate an unused PCI slot.
2. Remove the PCI slot cover.
3. Gently insert the RocketRAID 1740 into the PCI slot, and secure the bracket to

the system chassis.
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After installing the adapter, attach hard disks to the RocketRAID 1740 using an
SATA data cable. SATA cables have universal connections — either end can be
attached to the adapter or hard disk. Each RocketRAID 1740 included four
SATA cables, and supports up to four separate hard disks drives.

Many server-level chassis include hard-disk hot-swap bays. For these system
chassis, cables are attached to the chassis backplane, rather than directly to
each individual hard disk. Consult the chassis’s manual for proper installation
procedures.

Close and secure the system chassis.
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4 - Verifying Installation

Once the RocketRAID 1740 host adapter and hard disks have been installed into the

chassis, boot-up the system to verify that the hardware is properly recognized.

1. Power on the system. If the system detects the presence of the adapter, the
RocketRAID 1740 BIOS Utility will be displayed during bootup.

2. Press Ctrl+H to access the RocketRAID 1740 BIOS Utility.

The BIOS Utility will display information about hard disks attached to the adapter.

Make sure all attached disks are detected by this utility. If any of the hard disks are

not detected, power down the system and check the power and SATA cable

connections.
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RocketRAID 1740 BIOS Utility

The RocketRAID 1740’s BIOS Utility can be accessed using the “Ctrl+H”” command.

This command should be displayed automatically when the RocketRAID 1740’s BIOS
screen appears during the system’s boot up procedure.

1 - BIOS Command Overview

The RocketRAID 1740 BIOS Utility provides a wide selection of RAID related
commands. These commands are displayed towards the top of the utility’s interface.

RocketRAID 1748 BIOS Setting Utility vi.@
{c) 2884-2086. HighPoint Technologies. Inc. All rights reserved

elp
| Press <{Ctrl><H> to run BIOS Setting Utility |

Use the ¢— — arrow keys to scroll through the various commands, and the T

arrows to browse through the corresponding command menus. Use the ENTER key

to execute the selected command.

The ESC button can be used to cancel the selected command, or return to the previ-

ous command menu.

Create — this command is used to create RAID arrays. Section 2 discusses this

command in detail.
Delete — this command will delete the selected RAID array.

Warning: This command may result in permanent data loss - it should only be used if
data stored on the target array is no longer relevant, or has been backed up to an
alternate storage device.
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Add/Remove Spare — this command is used to assign hard disks to function as
spare disks. The controller is capable of using spare disks to automatically rebuild

broken or faulted RAID arrays. Section 3 discusses this command in detail.
Settings

Set Boot Mark — this function is used to designate a particular disk or RAID array to
function as the RocketRAID 1740’s boot device.

Note: This setting is only relevant if the motherboard’s BIOS has set the
RocketRAID 1740 to function as the system’s primary boot device.

Staggered drive spin up — this function is used to enable (or disable) staggered drive
spin up support This setting, by default, is disabled. Enabling staggered drive spin
up will power up the hard disks one at a time, approximately every two seconds.

View — this command is used to select between two views. Press the ENTER key to

change the view.

Devices — displays information about hard disks attached to the RocketRAID 1740.
Use the T 4 arrow keys to highlight the target hard disk, and press ENTER to view

the information.

RAID Arrays — displays information about RAID arrays attached to the RocketRAID
1740. Use the T { arrow keys to highlight the target array, and press ENTER to view

the information.
Initialize — this function is used to prepare disks for use with RAID arrays.

Note: Arrays cannot be created between disks that have not been initialized.

The following section discusses this command in detail.

2 - Creating RAID Arrays
Initializing Disks:

Before creating a RAID array, the disks must be initialized.

Initialization writes necessary RAID configuration information to the hard disk.
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Use the ¢— — arrow keys to select the Initialize command, and press ENTER.

Warning: Initialization will destroy all pre- existing data on the selected hard disks.

Use the T | arrow keys to highlight the target hard disk(s) and press ENTER. Next,
press the Y (yes) key to initialize the selected disk(s), or N (no) key to cancel the

initialization process.

Once initialized, these disks can be utilized to create RAID arrays.

To create an array:

L.

Use the <— —> arrow keys to highlight the Create command, and press ENTER

to open the Create Menu.
Use the T {4 arrow keys to select the appropriate RAID level, then press ENTER.
Next, use the d arrow key to highlight the Array Name option and press ENTER.

The array name dialogue box will appear. Use the keyboard to input a new Array
Name, and press the ENTER key.

Note: the Array Name command is optional — it is not necessary to name the
array. The array can be named at a later time, and the name of the array can be
changed at any time.

On the Create menu, use the { arrow key to highlight the Select Devices item and
press ENTER. A device list will appear, and display all available hard disk drives.
Highlight the target disks that you want to use, and press ENTER to select them.
After all of the disks have been selected, press the ESC key to return to the
Create Menu.

Next, Use the d arrow key to highlight the Capacity (GB) option and press
ENTER. The total available capacity will be displayed. Press ENTER if you wish
to use all available space.

If you wish to reserve disk space for additional arrays/single disks, use the
keyboard to input the amount of space (in GB) you wish to set aside for this
particular array, and press ENTER.

Note: Multiple arrays can be created using the same set of hard disk drives. The

Capacity option allows you to set aside disk space that be used to create another
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array, set as a spare disk, or partitioned to act as a single disk (by the operating
system).
8. To complete the creation procedure, use the d arrow key to highlight the Start

Creation item and press ENTER. Press the Y (yes) key to create the array, or N
(no) key to cancel the creation process.

3 - Adding/Remove Spare Disks

This command is used to assign a hard disk to act as a Spare Disk.

Spare Disks are used to automatically rebuild Redundant RAID arrays (RAID 1, 5, 10)
in the case of disk failure. To set a hard disk to act as a Spare Disk, use the T | arrow
keys to select a disk, and press ENTER.

To remove the Spare Disk setting from a hard disk, highlight the spare disk, and press
ENTER.

Generally, single disks are designated to act as spares (disks that are not configured
into RAID arrays).

However, in some instances, disks that are members of RAID arrays may also be
designated to act as a spare. If the disks in question are part of a RAID array that did
not utilize the full available capacity at the time of creation, these disks may be used
as spares.

For example: a RAID 0 array was created between two 200GB hard disks, but only
200GB of space (out of a grand total of 400GB), was assigned to that array. In this
example, 200GB of disk space remains unallocated. This unallocated space would
allow these disks to be set as spares for a separate redundant array that falls into the
same capacity range (200GB).

4 - Updating the BIOS

BIOS updates are released periodically, and posted on our website for download.
There are several ways to flash the RocketRAID 1740 BIOS.

I R —
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For Windows based operating systems:

)

2)

3)

4

3)

Download the desired BIOS update from the Support section provided for
the RocketRAID 1740 host adapter. Extract the download to the directory of
your choice.

Insert the Driver and Software CD included with the RocketRAID 1740 retail
box into the system’s CD-ROM or DVD drive.

The CD should autorun, and display the following screen:

ighPoint Products Software CD

ReadMe First

Create Driver Diskette

Install RAID Management Software
Browse the CD

Exit

Select the “Browse the CD” option, and access the directory provided for
the RocketRAID 1740 host adapter.

Open the “BIOS” directory, and double click the “hptflash.exe” icon. This
will start the BIOS flash utility:

ki HighPoint Flash Ukility x|

SATA Controller

Controller: 0] BocketBAID 17740

BIOS Image: Open... LCaonfig:..

Flazh Model: WINBOMD 330020 [0:B50A)

Elazhl | Backup | Exit
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8)

Select the RocketRAID 1740 from the drop down menu labeled “Controller”,
and press the “Open” button — this will allow you to browse to the extracted
BIOS download (step 1).

Highlight the image file, and click the “Flash!” button. The utility will update
the card, then verify the update.

Once complete, click on the “Exit” button to close the utility. Shutdown and

reboot the system.

Note: the “Backup” button will save a copy of the card’s current BIOS to the direc-

tory of your choice.

For other operating systems:

In order to update the BIOS, the system must be booted into DOS mode, using a
DOS-boot diskette or CD image.

)

2)

3)

4

5

Copy the load.exe and the bios image file to the bootable floppy diskette
(you may need to use a different floppy depending upon how much space is
available on the boot diskette - this can vary).

If you are booting from a CD image, you will need to add these files to the
CD.

Insert the boot image media into the appropriate drive, and boot the system.
Once the A:\> prompt has appeared, insert the media that contains the
required BIOS files, and type the following command:

load xxx.xxx

Then, press ENTER.

Note: xxx.xxx = the name of the BIOS image file (type it exactly as it appears).
The utility will scan for the controller, and ask if you want to backup the
BIOS (save a copy of the current BIOS to a floppy diskette). This is optional
- you can answer No, and continue.

Note: This option will not function if the system was booted from CD.

The utility will then ask if you want to flash the controller (upgrade the
BIOS). Select Y for yes.

The utility will display a progress bar during the flash procedure, then will
attempt verify the update.

Once complete, the system can be rebooted.
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Driver and Software CD
The RocketRAID 1740 retail box includes a Driver and Software CD.

This CD can be used to generate driver diskettes, and install the RAID Management
software for a variety of operating systems.

To create a driver diskette:

1. Insert the CD into the system’s CD/DVD drive. The program should start
automatically.

2. Insert a blank floppy diskette into the system’s floppy drive.

3. Click on “Create Driver Diskette”.

hPoint Products Software CD

ReadMe First

Create Driver Diskette

Install RAID Management Software
Browse the CD

Exit

4.  Click on the “Please Select a Product” drop-down button, and select
“RocketRAID 1740 from the list.

Create driver diskette x|

Pleaze zelect a product:

[RocketRATD 1740 =

Pleaze =zelect the diskette you want to create:

Windows driver

OK I Cancel

o] —
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5. Click on the “Please Select the Diskette you want to create” drop-down button,
and select the appropriate OS from the list.

eate driver diskette

Pleasze =zelect a product:

[RockstEATD 1740 =

Pleaze =zelect the diskette wou want to create:

Vindows driwver j

T
(1386) driver

Fedora Core 1
Fedora Core 2 (i386) driver
Fedora Core 2 (x86_84) driver J
Fedora Core 3 (1386) driver

mmFedora Core 3 (®86_84) driwver
Fedora Core 4 (1388) driver

Fedora Core 4 (x86_84) driver

Red Hat Enterprize Linux 3.0 driver (z&8)

Fed Hat Enterprize Linux 3.0 Update 1 driver (z&8)
Red Hat Enterprize Lirmx 3.0 driver (x86_#4)

Fed Hat Enterprise Lirux 4.0 driver (x86)

Fed Hat Enterprise Linux 4.0 driver (x86_64) i
5ufE Linux Enterprize 9 driver

SulE Linux 8.x driver

SuSE Linux 9.0 driwver

5usE Linux 9.1 driwer

SulE Linux 9.2 driwer hd

6. Click on the “OK” button to create the driver diskette.
To install the RAID software:
1. Click on “Install RAID Management Software”.

hPoint Products Software CDx

ReadMe First

Create Driver Diskette

Install RAID Management Software

Browse the CD

Exit

2. Select the desired software from the drop down menu, and click on the “OK”
button.
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Windows Driver Installation

Before installing the RocketRAID 1740 device driver, make sure the RocketRAID 1740
host adapter and all required hard disks have been installed into the system’s chassis

(refer to the Hardware Installation section, page 2-2).

Installing the RocketRAID 1740 driver for an existing Windows XP/
2003/x64 system

After the operating system has booted, Windows will automatically detect the
RocketRAID 1740, and request that a device driver be installed. To install the device

driver, follow the steps outlined below:

1.  When the “Found New Hardware Wizard” window appears, select “Install from a
list or specific location (Advanced)”, and click Next to continue.

2. Click on the “Include this location in the search” option, and select the system’s
floppy drive (generally Disk A). Next, insert the Driver Installation diskette into
the system’s floppy drive.

3. At the Hardware Wizard screen, select the floppy drive as the source, then click
the Next button. Select the appropriate operating system folder, then click the
Next button.

4. Windows will display a warning message that states the driver has “not been
signed”. Select “Continue Anyway”, then click Finish when prompted. When
windows asks to reboot the system, choose No.

5. Windows will then display a second “Found New Hardware Wizard” window —
repeat steps 1 through 4.

6. Remove the Driver Installation diskette from the floppy drive, then Shut down

and restart the computer.
Installation Verification

After the driver has been installed, and the system has been restarted:

1. Click the Start button, then right-click My Computer icon. Select the Properties
item from the popup menu.

2. In the popup window, select Hardware tab and then click Device Manager

43




RocketRAID 1740 Driver and Software Installation

button.
3. Double click the “SCSI and RAID controllers” entry. If the RocketRAID 1740
device entry is not displayed, or there are “?” or “!”
RocketRAID 1740 entry, the driver has not been installed properly. Delete the

entries and reinstall the driver.

marks displayed near the

Installing the RocketRAID 1740 driver during a fresh Windows 2000/
XP/2003/x64 installation

1. After booting from the Windows 2000/XP/2003 CD-ROM, when the Windows
Setup blue screen appears, look towards the bottom of the screen. Windows will
prompt you to press the F6 key if you want to install a third party SCSI or RAID
driver. Press the F6 key at this time.

2. The setup procedure will continue, and will later instruct you to press the “S” key
to specify additional adapters. Press the “S” key as instructed.

3. Next, the setup program will prompt for the insertion of the driver diskette. Please
insert the driver diskette, and then press ENTER to continue.

4. The next window will display several driver options. Please select the
RocketRAID 1740 Controller for the corresponding operating system, and press
ENTER to continue.

1 - Installing the RAID Management Console/ Interface Overview

To install the RAID software, locate the setup.exe file located on the floppy diskette
labeled “DISK 1” (or the Disk]1 folder, if the software was downloaded). Double click
this file to start the Installation Wizard.

Note: 1f the system chassis supports SAF-TE, make sure to select the corresponding

chassis-type/manufacturer when prompted.

There is no need to restart the system after installing the software. To start the
software, click on the “Start” button, select “Programs”, and click on the “HPT

Management Console.”
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Logging On

The RAID Management Console requires that a user (or Administrator) log on. The
software is incapable of working with RAID arrays or hard disks attached to the
RocketRAID 1740 until the user has logged on.

Default Parameters:

System Address: 127.0.0.1

Port: 7402

User Name: RAID

Password: hpt

Note: The password and user name fields are case sensitive.

The first time the software is used, make sure to enter the information listed above.

After successfully logging on, the software will ask you to alter the password (as a

security precaution).

Enter a password, and press ENTER.

2 - Software Interface - Overview of commands/functions

After logging on, several new options will become available.

These commands are displayed towards the top of the interface window:

4-5 e




RocketRAID 1740 Driver and Software Installation

& HighPoint RAID Management Console - Array Management

File Management ‘iew Operation Help

T -4 & i (=

Create Delete Fename Unplug OCE/ORLM Fescan

Overview of Function - menus (tabs)

File

Remote Control — view information about remote systems

System Configuration — switch between available remote systems
User Management — add or remove users, edit user profiles
Password — change the password

Exit — exit the utility interface

Management

RAID Management — create/delete/maintain RAID arrays

Device Management — check information or change settings for host adapters, and
hard disks

Spare management — create and assign spare disks

System Notification — set up system notification options

View

Event view — views the event log

Icon view — view icon descriptions (legend)

Operation

This menu will list all available commands for the selected Function menu.

These commands are also represented in icon/button form (below the function-menu/
tabs selections)

Help
Search through help topics related to the RAID Management Console software

View software version information
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3 - Creating an Array

To create an array:

L.

Highlight the “Management” menu, then select the “Array Management”
function.
Click the Create button on the toolbar or select the “Create” command from the

“Operation” menu. The array creation wizard will appear.

Select the desired RAID level from the drop-down list.

Enter a name for the array using the keyboard (this is optional), and click the Next
button.

If you are creating a redundant array (RAID 1, 5, 10), select an initialization

option. Ifyou are creating a RAID 0 or JBOD (volume), skip to step 6:
For RAID 1 and RAID 10 arrays, the default initialization method is “No
initialization”.

For RAID 5 arrays, the default initialization method is “Foreground”.

If you are creating RAID 5, you will be asked to specify a cache policy:

Write-back - when the write-back setting is selected, all write requests sent to
the array are cached. This will result in higher performance, but data loss may

occur in case of a power failure.
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6.

Select which disks are to be used to create the array. Highlight the desired disk
from the left-side of the interface (available disks), then click on the button to
move the disk to the right side of the interface (selected disks). Disks must be

selected one a time.

If you wish to remove a selected disk, highlight it from the selected disk section,

and use the button to move it to the available disk section.

Note: The selection sequence is important - the order in which the disks are
selected will determine the disk sequence of the array.

Select the capacity - the RocketRAID 1740 can create arrays between partitions
on various disks. It is not limited to physical hard disk drives. As a result of this
feature, you have the option of assigning a physical disk to multiple RAID

arrays.

Press ENTER to use the default value (the maximum capacity for the array), or
specify the desired value using the keyboard, and press ENTER to confirm this
selection. Then, click the Finish button.

Note: If you have specified an initialization option, the initialization process will start

automatically. A progress bar will be displayed towards the bottom of the interface

window, and will indicate % completion, and provide an estimate of the time needed

to complete the initialization procedure.

4 - Deleting an Array

To delete an array:

L.

Highlight the “Management” menu, then select the “Array Management”
function.

Highlight the array you want to delete, then click on the “Delete Icon” or select
the Delete command from the “Operation” menu.

A warning message will appear. Click Yes to delete the array. Click on cancel to
stop this procedure.

Note: An array in use by the operating system cannot be deleted. Any data stored on

a deleted array will be inaccessible.
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5 - Configuring Spare Disks
Spare disks can be used to rebuild redundant RAID arrays in the case of failure.

To configure spare disks, highlight the “Management” menu, and select the “Spare
Management” function. The Spare Management window will appear.

To add a spare disk, select it from the Available Disk list box and click the button
to add the disk to the Spare Pool list box.

To remove a spare disk, select it from the Spare Pool list box and click the button

to remove the disk from the Spare Pool list box.

6 - Recovering/Verifying Arrays

When an array member (hard disk) of a redundant array fails, the array will be marked

as “broken”.
Broken arrays can be automatically rebuilt using hot-spare disks (see page 4-9).

However, if there are no available spare disks, you can still rebuild the array by
adding a new disk to it. To add a disk to a broken array:

1. Highlight the “Management” menu, and select the “Array Management”
function.

2. Highlight the broken array that needs to be rebuilt.

3. Click the Add Disk button on the toolbar or select “Add Disk” command from the
“Operation” menu.

4. If the disk is successfully added to the array, rebuild process will start

automatically.

Note: In some instances, a failed array will not rebuild automatically.

To manually start the rebuild process for a broken/critical array:

1. Highlight the “Management” menu, and select the “Array Management”
function.
Highlight the array that needs to be rebuilt.

3. Click the Rebuild button on the toolbar or select the “Rebuild” command from the
“Operation” menu.
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Verifying an Array

For a RAID 1 or RAID 10 array, the verify process compares the data of one mirror
pair with the other (single hard disk in the case of RAID 1, and a paired set of disks
for RAID 10).

For RAID 5, the verify process calculates RAID 5 parity and compares it to the parity
data on the array. Verification checks each sector on a given disk. Periodic verifica-
tion of an array allows the disk drive firmware to take corrective actions on problem

areas on the disk, minimizing the occurrence of uncorrectable read and write errors.

To verify an array:

1. Highlight the “Management” menu, and select the “Array Management”
function.

2. Highlight the array you want to verify.

3. Click the Verify button on the toolbar or select the “Verify” command from the
“Operation” menu.

4. Verify process will start.

7 - OCE/ORLM

The RocketRAID 1740 supports both OCE (Online Capacity Expansion), and ORLM
(Online RAID Level Migration).

The RAID software provides support for these features through a single function,
known as OCE/ORLM.

With the OCE/ORLM function, you can transform an array from one RAID level to
another RAID level and/or resize the array dynamically, even under I/O load.
To perform OCE/ORLM on an array:

1. Highlight the “Management” menu, and select the “Array Management”
function.

2. Highlight the array you want to alter.

3. Clickthe M button on the toolbar or select “OCE/ORLM” command from

OCE/DRLM

the “Operation” menu.
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4. The OCE/ORLM window will appear.

The interface is very similar to the Array Creation Wizard interface. Select the

type of array you wish to change the existing array into, then set any corre-

sponding parameters (cache/ initialization options, capacity, if relevant).

Notes:
1.

When expanding a JBOD array, all the original disks must be included in the
target array, and these disks must be selected in the same order (as the
original array). If you want to migrate a JBOD array to another RAID level,
only the first member disk can be included in the target array. For example, a
JBOD comprised of 3 disks (1, 2, 3), can only be “migrated” using disk 1.
Disks 2 and 3 cannot be used — disk 1 would have to be combined with other
disks attached to the RocketRAID 1740 (4, 5, 6, 7, 8).

You cannot change an array to another type of array with a smaller capacity.
In some cases, a disk may need to be added to the RocketRAID 1740.
During the OCE/ORLM procedure, the redundancy level of the array will be
the lowest of the source and target arrays; e.g. if you ORLM a RAID 0 array
to a RAIDI array, the array will be non-redundant until the procedure is
complete.

The OCE/ORLM process can be aborted and continued at later time.
However, you should always stop the transform progress from the RAID
Management software.

An unexpected system crash may result in data loss while performing OCE/

ORLM on an array.

8 - Misc. Array/Device Options

Device Management

The Device Management window provides configuration information about control-
lers (the RocketRAID 1740 and other HighPoint host adapters), channels and hard

disks.

To access the Device Management window, highlight the “Management” menu, and

select the “Device Management” function.
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Changing Device Settings

Depending upon the hard disk in question, and support provided by the current
device driver, you can adjust settings for disk: Read Ahead, Write Cache, TCQ, and
NCQ. Each feature can be enabled or disabled individually.

S.M.A.R.T Status

You can view S.M.A.R.T. (Self-Monitoring, Analysis, and Reporting Technology)
data about a drive to help troubleshoot any problems that occur. You can also setup
periodical S.M.A.R.T. status checks that send notification messages when S.M.A.R.
T. thresholds are exceeded.

To view the S.M.A.R.T status of a hard disk:

1. Highlight the “Management” menu, and select the “ Device Management”
function.

2. Highlight the disk you want to examine.

3. Select the “SMART” command from the “Operation” menu, or click on the

SMART

button to display the S.M.A.R.T status/settings window.

SAF-TE Management

& HighPoint RAID Management Console - SAF-TE Enclosure Management E|E|E|

Filz Management Wiew Help
M ame Statuz
Temperature 0
Fan Speed 0
Temperature Limit B0
Slot & Fail LED On
Slot B Fail LED aff
Slot C Fail LED aff
Slot D Fail LED ulij
Connected system 051 Microsoft Windaws XP Professional System 'LocalHost' connected

This feature allows the administrator to view and monitor a variety of SAF-TE related
attributes, such as chassis temperature readings, disk failure, and the status of the

chassis cooling apparatus (cooling fans).
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Note: This feature is dependent upon the system chassis — this function will not be
available unless the chassis supports SAF-TE.

Renaming an Array

1. Highlight the “Management” menu, and select the “Array Management”
function.

2. Highlight the array you want to rename.

3. Click the Rename button on the toolbar or select the “Rename” command from
the “Operation” menu.

4. Enter a new name for the array using the keyboard, and press the OK button to
confirm your selection.

Note: An array running background tasks cannot be renamed.

9 - Managing Events

The HighPoint RAID Management Console will log all events that have occurred on
any host adapter under it’s control.

Viewing Logged Events

To view logged events:

1. Highlight the “View” menu, and select the “Event View” option.
2. Inthe Event View window, you can filer events, clear events, and save events to

afile.

Configuring E-mail notification

To enable E-mail notification:

1. Highlight the “Management” menu, and select the “Event Notification” function.
2. Click the Setting button on the toolbar or select “Setting” option from the
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“Operation” menu.

3. Next, enter the necessary information in the E-mail Notification Setting window.

E-mail notification setting &|

ak.
[ Enable E-mal Matificatior:
| x Cancel

SMTP Server: |

Part: 23

b il From:

Note: The software does not support SMTP servers that require user authentication.

To add a Recipient:

Highlight the “Management” menu, and select the “Event Notification” function.
2. Click the “Add” button on the toolbar or select “Add” command from the
“Operation” menu.

3. Enter the necessary information in the Add recipient window.

Add recipient [X|
E-mail: || ~/ o
x Cancel
Mame: |

M atification Optianz

[ Information
[ Warning
[w Errar

4. The recipient will be listed in the main window. You can use Modify or Delete

button on the toolbar to modify or delete the recipient.

— 414




RocketRAID 1740 Driver and Software Installation

To test E-mail notification:

1.  Highlight the “Management” menu, and select the “Event Notification”

function.

2. Select one recipient from the main window.

3. Click the Test button on the toolbar or select the “Test” command from the

“Operation” menu.

4. The software will send a “test” e-mail message to the selected recipient.

Managing Tasks

The RAID management Console can be used to setup routine, periodical background-

rebuild or verification tasks that will help maintain the integrity of RAID arrays

attached to the RocketRAID 1740.

To setup and schedule tasks highlight the “Management” menu, and select the “Task

Management” function to open Task Management window.

Task Management

[E

MHew

Task schedule list:

[55 Datie |

X

MName

| TaskType

| Create date-time

| Lazt modify date... | Create manager

The Task Schedule list displays all of the tasks assigned to the selected remote

system. To view detailed information about a specific task, highlight and Double-click

the task’s name.
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Add a Scheduled Task

This command is used to add a Scheduled task for the selected remote system. To

add a new scheduled task:
Click the “New” button on the toolbar. The new task schedule wizard will appear.

New task schedule wizard f5_<|

Pleaze select tazk pe:
& Veihy
" Rebuid

Please select an array that you want to ety or rebuild:

Available arrays: ‘@ RalD_1_0 j

x Eancel| | Hemtz: |

Select the task type and the array that you want to verify or rebuild, then click
“Next”.
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Mew task schedule wizard f5_<|

Connected system curent date-time: 2442005 3:47:09 P
Array Mame; RalD_1_0
Taszk Type: Werify

T azk name: ety RalD_1_0

Frequency

{* Occurs one time on | 2/ 452008 <= at | 3d1:09 Ph==

i Dccursgver_l,l| ﬂ | J
at —

Duration

Start date: = -

[+ Enable the tazk

x Eancel‘ <<Back ‘ Finizh |

Enter a name for the task.

Configure the frequency for the task.

Set the duration for the task.

Check the “Enable the task™ option to activate this task.
Click “Finish”.

RAEEE I S .

Modify a Scheduled Task
This command is used to change settings for a scheduled task. To Modify a Task
Schedule:

1. Select a task from the Task schedule list.
2. Click the “Modify” button on the toolbar, and modify the task settings in the

popup window.
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Delete a Scheduled Task

This command is used to delete a Scheduled Task for the selected remote system. To
delete a Task Schedule:

1.  Select a task from the Task schedule list.
2. Click the “Delete” button on the toolbar.

10 - Configuring Remote Systems

Then HighPoint RAID Management Console manages a RAID controller through a
connection to the HighPoint RAID Management Service, which runs on the system
where the RAID host adapter is physically installed. This type of system is referred

to as a “remote system”.

Note: What the software classifies as a “remote system” may not always be an actual
remote computer. In some configurations, the local computer hosts both the RAID
host adapter and Management Service. The local system, in these cases, is still

generically referred to as a “remote system”.

Add a Connection

This command is used to add new connection to a remote system. To Add a
Connection:
Highlight the “File” menu, and select the “Remote Control” function.
2. Click the Add button on the toolbar or select the “Add” command from the
“Operation” menu.

3. Enter the system address, name, and port information in the popup window.
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o 0K

System Address: ||

x Cancel

i

Syztem Mame: |

System Port: |

02

The system address can be a host name, or an IP address. The default system port is

7402.

4. Click “OK” to finish adding the new connection.

Modify a Connection

This command modifies connection information for a remote system. To modify a

connection:

Highlight the “File” menu and select the “Remote Control” function.

2. Highlight the system you want to modify.
Click the Modify button on the toolbar or select the “Modify” command from the

“Operation” menu.

Modify Connection

System Address:

System Port:

3

X Cancel

Syztem MName: |Ll:u:a| Hosthhptmve

7402
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4.  Enter new connection information in the popup window, and click OK to apply
the changes.

Note: The System Address cannot be modified. If you insist on modifying this item,
you must first delete this connection and then add a new connection. In addition, the
connected system cannot be modified — you must first disconnect from this system.

Delete a Connection

This command deletes a remote system from the connection list. To delete a

connection:

Highlight the “File” menu and select the “Remote Control” function.

2. Highlight the system you want to delete.
Click the “Delete” button on the toolbar or select the “Delete” command from
the “Operation” menu.

4. A warning message will be displayed. Click “Yes” to delete the item. Select No
to cancel this command.

Connect to a Remote System

This command establishes a connection to a remote system for RAID management.
To connect to a remote system:

Highlight the “File” menu and select the “Remote Control” function.

2. Highlight the remote system you to establish a connection with.

3. Click the “Connect” button on the toolbar or select the “Connect” command
from the “Operation” menu.

4. Enter the appropriate Login information in the popup window.
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Note: The initial user name/password for a remote system is RAID/hpt. You are free

to modify the username and password after the connection is established.

If the connection is successful established, the application will retrieve the event logs

from the remote system, then switch to Array Management view.

Disconnect Remote System

This function closes the connection from a connected system. To disconnect a

remote system:

1.  Highlight the “File” menu and select the “Remote Control” function.
2. Highlight the system you want to disconnect from.

3. Select the “Disconnect” command from the “Operation” menu.

System Configuration

This function is used to modify the service configuration on a remote system. To
change the service configuration:

1.  Highlight the “File” menu and select the “Remote Control” function.
2. Highlight the remote system you want to modify.

3. Select the “System Configuration” option from the “Operation” menu.
4

Modify the information in the popup window.
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System Configuration

X

W DK
x Cancel

System Port:

Ewvent Port; | 7403

System Port — This is the TCP port number that the RAID Management Service uses
to communicate with RAID Management Console. When you connect to the service,
the port value you enter must be in accordance with the system port value on the

service. The default value is 7402.

Event Port— The client software will retrieve events through this port. The default
value is 7403.

The System Port value must differ from the value assigned to the Event Port. After
you reset a system’s configuration, you should restart the service on that system for

the changes to take effect.
5. Click “OK” to apply the changes.

11 - Configuring Users and Privileges

The RAID Management Console allows the Administrator to manage user accounts in
its own database. You can setup multiple users and assign different privileges levels

for the purpose of RAID management.

Users can be assigned to each individual Remote System controlled by the RAID

Management Console.

Highlight the “File” menu and select the “User Management” function to configure

User related options for the selected remote system.
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The user management window lists all users assigned to the selected remote system.

The current/active user will be designated with an icon.
Add a User

This function adds a user account to the connected remote system. To add a user:

Click the “Add” button in the User Management window.
2. In the popup window, enter the user name, enter and confirm the password, and
then click “Next”.

3. Select the appropriate privileges for the user.
4. Click “Finish”.
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Delete a User

This function deletes a user’s account on the connected remote system. To delete a

user:

1. Select the target user ID from the User list displayed in the User Management
window.
2. Click Delete to remove the selected user. Click “Yes” to delete the item. Select

“No” to cancel this command.

Note: An active user (user currently utilizing the software) cannot be deleted from the
console.

Set Password

The Administrator uses this function to set a user’s password — the password allows
a user to log on to a remote system, and utilize the RAID Management Console. To

set password for a user:

1. Select the target user ID from the user list displayed in the User Management
window.
2. Click the “Set Password” option, and enter the password for the user.

3. Click OK to apply your selections.

Set Privilege
The Administrator uses this function set a user’s privileges for the selected remote
system. To set privileges for a user:

1. Select the target user ID from the user list displayed in the User Management
window.
2. Click the “Set Privilege” option.
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3. In the popup window, assign the privileges for the selected user.

4.  Click OK to apply your selections.
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Fedora Core 4 Linux installation Overview

This section provides instructions describing how to install and utilize the
RocketRAID 1740 Adapter on a Fedora Core 3 Linux system.

1 - Installing Fedora Core 4 on the RocketRAID 1740 Host Adapter

Note: If the OS is running kernel that differs from the one supported by the
precompiled driver, the precompiled drivers cannot be used. A driver can be built for
this kernel using the OpenSource package for the RocketRAID 1740 controller. This
package is available from our website, and is posted on the BIOS/Driver page for the
RocketRAID 1740.

To install Fedora Linux onto hard disks or RAID arrays attached to RocketRAID 1740

controller, follow the steps outlined below:

Step 1 Prepare the Driver Diskette
The driver is contained in a floppy diskette image file.

On a DOS or Windows system, a Fedora driver diskette can be generated using
rawrite.exe. This utility is included on the Fedora Linux CD (under /dosutils). Run

rawrite using a command prompt window, and follow the directions it provides.

On a Linux system, use the “dd” command to generate a boot diskette. Insert a

floppy disk into the floppy drive and type the following command:
# dd if=fc3-1386.img of=/dev/fd0

Note: The driver disk image file depends on your core version and hardware.

Step 2 Install Fedora Linux

Installation steps for Fedora Core 4

1) Boot from the Fedora Installation CD, and start the install procedure.
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2)  Atthe “Welcome to Fedora Linux” installation screen, a prompt labeled “boot:”
will appear at the bottom of the screen. Type in linux dd, then press ENTER.

boot: linux dd

3)  When prompted “Do you have a driver disk?”, select “Yes”. At the “Insert your
driver disk and press OK to continue” prompt, insert the driver diskette in the
floppy drive and then select “OK”.

4)  The system will now load the RocketRAID 1740 driver automatically.

Note: For the Fedora Core 3 x86_64 version, there is an option to disable the NMI
watchdog.

Some hard disk’s long reset time will cause the NMI watchdog to fault. Add the kernel

command line “nmi_watchdog=off".

2 - Installing the RocketRAID 1740 driver for an Existing System

Note: 1f a SCSI adapter is used to boot the system, make sure the RocketRAID 1740
controller BIOS loads/posts after the SCSI adapter’s BIOS. It may be necessary to
move the adapter(s) to another PCI slot.

Step 1 Obtain the Driver Module

Extract the module file from the file modules.cgz (from the driver disk) using the

following commands:
# mount /dev/fd0
# cd /tmp
# gzip -dc /media/floppy/modules.cgz | cpio -idumv

Driver modules for all supported kernel versions will be extracted. The driver module
for the active kernel is located under the directory that matches the kernel version (/
tmp/‘uname —1°/1686/rr1740.ko).

After extracting the driver module, load it using the following commands:
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# modprobe sd_mod
# insmod rr1740.ko

Arrays attached to the adapter can be accessed as SCSI devices (e.g. /dev/sda).

Step 2 Mounting and Partitioning the Device
Example: A RAID array has been configured between several hard disks.
This array will be registered to the system as device “/dev/sda”.

To create a partition on this array (which will listed as /dev/sdal), use the “fdisk /

dev/sda” command.
Next, use the “mkfs /dev/sdal” command to setup a file system on this partition.

Use the command “mkdir xxxx” to create a mount point for the RAID array. Then

mount /dev/sdal /xxxx in order to access it.

Note: xxxx represents the desired name of the mount point.

Step 3 Configure System to Automatically Load the Driver

To avoid typing in “insmod rr1740.ko” each time the operating system is booted, the
system must be instructed to automatically load the module during bootup. To install
the module, type in the following commands (first change to the directory where the

proper rr1740.ko file is located):
#cp rr1740.ko /lib/modules/‘uname —r*/kernel/drivers/scsi
#depmod

Then, instruct the system to load the module when booting. Use the following

commands:
#echo “modprobe 1r1740” > /etc/init.d/hptdriver

#chmod 755 /etc/init.d/hptdriver
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#ln —sf /etc/init.d/hptdriver /etc/rc.d/rc3.d/SO1hptdriver
#ln —sf /etc/init.d/hptdriver /etc/rc.d/rc4.d/SO1hptdriver

#ln —sf /etc/init.d/hptdriver /etc/rc.d/rc5.d/SO1hptdriver

Step 4 Configure System to Mount Volumes during Startup

The system can be instructed to automatically mount the array(s) during startup by
modifying the file”/etc/fstab”.

For example, add the following line to tell the system to mount /dev/sdal to location /

mnt/raid after startup:

/dev/sdal /mnt/raid ext3 defaults 00

3 - Updating the Driver

1. Ifthe original driver is installed in the system’s initrd (Initial RAM Disk) file
(when using a system installed to the RocketRAID 1740 controller, for example),
the driver module in the initrd file should be updated using the mkinitrd com-
mand (or extract the initrd file and replace the driver module manually).

2. If the original driver is installed in the /lib/modules/‘uname —r‘/kernel/drivers/
scsi/ directory, and loaded by the script file (Example /etc/init.d/hptdriver) during
the init process, or the configure file (Example /etc/modules.conf), please replace
it with the new driver (rr1740.0 or rr1740.ko).

4 - Uninstalling the Driver

To uninstall the RocketRAID 1740 driver

Note: The driver cannot be uninstalled while the system is booted from a disk or array
attached to the RocketRAID 1740.

To uninstall the driver, remove the lines added to /etc/fstab, and remove the files
created in the /etc/init.d directory.
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Red Hat Enterprise 4 Overview

This section provides instructions describing how to install and utilize the
RocketRAID 1740 Adapter on a Red Hat Enterprise 4 Linux system.

1 - Installing Red Hat Enterprise 4 (AS, ES, WS) Linux on the
RocketRAID 1740 controller

To install Red Hat Enterprise Linux onto disks or RAID arrays attached to
RocketRAID 1740:

Step 1 Prepare the Driver Diskette
The driver is provided in a floppy diskette image file format.

On a DOS or Windows system, a driver diskette can be generated using rawrite.exe.
This utility is included on the Red Hat Enterprise Linux CD (under /dosutils). Run

rawrite using a command prompt window, and follow the directions it provides.

On a Linux system, use the “dd” command to generate a boot diskette. Insert a
floppy disk into the floppy drive and type the following command (amd64 driver for

example):

# dd if=rh3dd-amd64.img of=/dev/fd0

Step 2 Install Red Hat Enterprise Linux

Start installing Red Hat Enterprise Linux by booting from the installation CD.
2. Atthe “Welcome to Red Hat Linux” installation screen, a prompt labeled “boot:”

will appear at the bottom of the screen. Type in linux dd, then press ENTER.
boot: linux dd

3. When prompted “Do you have a driver disk?”. Select “Yes”.
4. When prompted “Insert your driver disk and press OK to continue”, insert the

driver diskette into the system’s floppy drive, and select “OK”.
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The system will now load the RocketRAID 1740 driver automatically.

When prompted “Where do you want to install the boot loader? ” in the “Boot
Loader Configuration” dialog, select “Master Boot Record (MBR)” to instruct
the system be to boot from the RocketRAID 1740.

Continue the installation as normal. You can refer to Red Hat Enterprise Linux installa-

tion guide.
Note:

The system device mapping order is the same as the order shown in RocketRAID
1740 BIOS Setting Utility. If no other SCSI adapters are installed, the device marked
as “BOOT” or “HDDO0”will identified as /dev/sda, “HDD1” as /dev/sdb, “HDD2” as /

dev/sdc, etc. When creating mount points, /boot must be mounted on /dev/sda.

2 - Installing the RocketRAID 1740 driver for an Existing System

Note: If a SCSI adapter is used to boot the system, make sure the RocketRAID 1740
controller BIOS loads/posts after the SCSI adapter’s BIOS. It may be necessary to
move the adapter(s) to another PCI slot.

Step 1 Obtain the Driver Module

Extract the module file from the file modules.cgz (from the driver disk) using the

following commands:
# mount /dev/fd0
# cd /tmp
# gzip -dc /mnt/floppy/modules.cgz | cpio -idumv

Driver modules for all supported kernel versions will be extracted. The driver module
for the active kernel is located under the directory that matches the kernel version (/

tmp/“uname —r*/rr1740 ko).

After you have extracted the driver module, you can load it by following commands:
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# modprobe sd_mod

# insmod rr1740.ko

Arrays attached to the adapter can be accessed as SCSI devices (e.g. /dev/sda).

Step 2 Mounting and Partitioning the Device
Example: A RAID array has been configured between several hard disks.
This array will be registered to the system as device “/dev/sda”.

To create a partition on this array (which will listed as /dev/sdal), use the “fdisk /
dev/sda” command.

Next, use the “mkfs /dev/sdal” command to setup a file system on this partition.

Use the command “mkdir xxxx” to create a mount point for the RAID array. Then,

mount /dev/sdal /xxxx in order to access it.

Note: xxxx represents the desired name of the mount point.

Step 3 Configure System to Automatically Load the Driver

To avoid typing in “insmod rr1740.ko” each time the operating system is booted, the
system must be instructed to automatically load the module during bootup. To install
the module, type in the following commands (first change to the directory where the
proper rr1740.ko file is located):

# install -d /lib/modules/‘uname —r‘/kernel/drivers/scsi
# install -c rr1740.ko /lib/modules/‘uname —r*/kernel/drivers/scsi

Then, instruct the system to load the module when booting. Use the following
commands:

#echo “modprobe 1r1740” > /etc/init.d/hptdriver
#chmod 755 /etc/init.d/hptdriver

#ln —sf /etc/init.d/hptdriver /etc/rc.d/rc3.d/SO1hptdriver
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#ln —sf /etc/init.d/hptdriver /etc/rc.d/rc4.d/SO1hptdriver

#ln —sf /etc/init.d/hptdriver /etc/rc.d/rc5.d/SO1hptdriver

Step 4 Configure System to Mount Volumes during Startup

The system can be instructed to automatically mount the array(s) during startup by
modifying the file”/etc/fstab”.

For example, add the following line to tell the system to mount /dev/sdal to location /

mnt/raid after startup:

/dev/sdal /mnt/raid ext2 defaults 00

3 - Updating the Driver

If you are not booting from disks attached to RocketRAID 1740 controller, you can
update the driver just by reinstalling it following the procedure outlined in the

previous section, “Installing the RocketRAID 1740 driver for an Existing System”.

If you are running the system installed to a disk or array attached to the RocketRAID
1740:

First, obtain the new driver module “rr1740.ko”. Refer to the previous section
“Obtain the Driver Module”. In following steps, we assume it has been copied to
“/tmp/rr1740.ko”.

Replace rr1740.0 in the boot RAM disk image, /boot/initrd-xxx.img (where xxx is

the kernel version).
Example: (2.4.21-4.EL for Red Hat Enterprise Linux 3.0):
# gzip -dc /boot/initrd-xxx.img > /tmp/initrd.ext2
# mkdir /mnt/initrd
# mount -o loop /tmp/initrd.ext2 /mnt/initrd

# cp /tmp/rr1740.0 /mnt/initrd/lib/rr1740.0
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# umount /mnt/initrd
# gzip -c /tmp/initrd.ext2 > /boot/initrd-xxx.img
If you are using lilo to boot the system, use “lilo” to reinstall the RAM disk:
#lilo
Update rr1740.0 in /lib/modules:
# cp /tmp/rr1740 ko /lib/modules/‘uname —r*/kernel/drivers/scsi/rr1740.ko

Reboot your system to allow the new driver take effect.

4 - Uninstalling the Driver

To uninstall the RocketRAID 1740 driver

Note: The driver cannot be uninstalled while the system is booted from a disk or array
attached to the RocketRAID 1740.

To uninstall the driver, remove the lines added to /etc/fstab, and remove the files

created in the /etc/init.d directory.
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SuSE Linux Enterprise Server (SLES) installation Overview

This section provides instructions describing how to install and utilize the
RocketRAID 1740 Adapter on a SuSE (SLES) Linux system.

1 - Installing SLES Linux on the RocketRAID 1740 Host Adapter

Note: If the OS is running kernel that differs from the one supported by the
precompiled driver, the precompiled drivers cannot be used. A driver can be built for
this kernel using the OpenSource package for the RocketRAID 1740 controller. This

package is available from our website, and is posted on the BIOS/Driver page for the

RocketRAID 1740.

To install SLES onto hard disks or RAID arrays attached to RocketRAID 1740
controller, follow the steps outlined below:

Step 1 Prepare the Driver Diskette
The driver is contained in a floppy diskette image file (slesdd.img).

On a DOS or Windows system, a driver diskette can be generated using rawrite.exe.
This utility is included on the SLES Linux CD (under /dosutils). Run rawrite using a

command prompt window, and follow the directions it provides.

On a Linux system, use the “dd” command to generate a boot diskette. Insert a
floppy disk into the floppy drive and type the following command:

# dd if=SLESdd.img of=/dev/fd0

Step 2 Install SLES Linux

1. Start the install procedure by booting from SLES installation CD.
2. After the CD boots, select the “Installation” option and press F6 to load the
driver.

3. Insert the Driver Diskette when it displays “Please insert the Driver Update
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floppy”.
4. When the “Diver Update Menu” is displayed, press “OK” and “back” for back

to installer.
Next. Select “back” to return to the installer.
Installation will now proceed normally. Refer to SLES Linux documents for
additional OS installation procedures.
Additional Installation Notes:

The system device mapping order is the same as the order shown in RocketRAID

1740 BIOS Setting Utility. If no other SCSI adapters are installed, the device marked
as “BOOT” or “HDDO0” will be identified as /dev/sda, “HDD1” as /dev/sdb, “HDD2”
as /dev/sdc, etc. When creating mount points, /boot must be mounted on /dev/sda.

2 - Installing the RocketRAID 1740 Driver on an Existing System

If you are currently running SLES and would like to access drives or arrays attached
to the RocketRAID 1740 controller, follow the steps outlined below:
Note:

1. Ifa SCSI adapter is used to boot the system, make sure the RocketRAID
1740 controller BIOS loads/posts after the SCSI adapter’s BIOS. It may be
necessary to move the adapter(s) to another PCI slot.

2. The driver may work incorrectly on certain motherboards (such as DFI77B
KT400). For these motherboards, add the “acpi=off” kernel parameter in the /
boot/grub/menu.lst:

kernel (hd0,1)/vmlinuz root=/dev/hdal acpi=off

initrd (hd0,1/initrd

Step 1 Update Grub

If you are running an SLES SMP System, you must first update the /boot/grub/menu.
Ist.
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Example:

default=0

timeout=8

title Linux

kernel (hd0,1)/vmlinux root=/dev/hdal acpi=off

initrd (hd0,1)/initrd

Reboot the system to allow the new kernel parameters to take effect.

Step 2 Install the Driver Module

Extract the module file from the file /linux/suse /[arch]-[version]/install/update.tar.gz

(from the driver disk), using the following commands:
# mount /dev/fd0 /mnt/floppy
#ed/
# tar xfz /mnt/floppy/linux/suse/i386-sles9/install/update.tar.gz

The driver modules will be extracted to the directory /lib/modules/[kernel-ver]/kernel/

drivers/scsi/ .

After you have extracted the driver module, you can load it by following commands:
# modprobe sd_mod
# insmod rr1740.ko

Then you can access the arrays attached to the controller as SCSI devices (e.g. /dev/
sda).

Step 3 Mounting and Partitioning the Device

Note: Many versions of SuSE include YAST. YAST is a graphical configuration
utility that is capable of executing the commands described below. We recommend
using YAST, if available, as it may help simplify the installation process.
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Example: A RAID array has been configured between several hard disks.

This array will be registered to the system as device “/dev/sda”.

L.

To create a partition on this array (which will listed as /dev/sdal), use the
“fdisk /dev/sda” command.

Next, use the “mkfs /dev/sdal” command to setup a file system on this
partition.

Use the command “mkdir xxxx” to create a mount point for the RAID array.

Then, mount /dev/sdal /xxxx in order to access it.

Note: xxxx represents the desired name of the mount point.

Step 4 Configure System to Automatically Load the Driver

To avoid typing in “insmod rr1740.0” each time the operating system is booted, the

system must be instructed to automatically load the module during bootup. To install

the module, type in the following commands (first change to the directory where the

proper rr1740.ko file is located):

1. Edit the file “/etc/sysconfig/kernel”, and add the rr1740 module to the line
“INITRD_ MODULES=...”
Example:
INITRD MODULES="reiserfs 1r1740”
2. Run the “depmod” command to update the module configuration:
# depmod
3. Next, run the “mkinitrd” command to update the initrd file:
# mkinitrd
4. Ifyou are using the lilo boot loader, run lilo again:

#lilo

Step 5 Configure System to Mount Volumes during Startup

The system can be instructed to automatically mount the array(s) during startup by
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modifying the file”/etc/fstab”.

For example, add the following line to tell the system to mount /dev/sdal to location /
mnt/raid after startup:

/dev/sdal /mnt/raid ext2 defaults 00

3 - Updating the Driver

To update the driver, simply reinstall the driver following the steps in previous
section, “ Install RocketRAID 1740 Driver on an Existing System .

Note: If the driver is loaded in initrd (when system is installed onto a disk or array
attached to the RocketRAID 1740), you need to run the mkinitrd command to update
the initrd file. If you are using the lilo boot loader, run lilo again (# lilo).

4 - Uninstalling the Driver

To uninstall the RocketRAID 1740 driver

Note: The driver cannot be uninstalled while the system is booted from a disk or array
attached to the RocketRAID 1740.

To uninstall the driver, remove the lines added to /etc/modules.conf and /etc/fstab.
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1 - Installing FreeBSD on the RocketRAID 1740 Controller

If you would like to install FreeBSD onto arrays attached to the RocketRAID 1740

host adapter, please follow the steps below.

Step 1 Prepare the Driver Diskette

When installing FreeBSD to a disk or array attached to the RocketRAID 1740, you
must prepare a RocketRAID 1740 driver diskette before starting the installation

procedure.
First, obtain the driver diskette image file from the driver package.

In a DOS or Windows system, create the boot diskette using the rawrite.exe utility.
This utility can be found on the FreeBSD CD (under \tools). Run it under a DOS-

Prompt window and follow it’s prompt.
On a FreeBSD system, use the “dd”” command to make the driver diskette. For
example, Insert a floppy disk into the floppy drive and type the following command (if

you are installing FreeBSD 5.x versions):

# dd if=freebsd_5.x.img of=/dev/fd0

Step 2 Install FreeBSD

Start the FreeBSD installation procedure by booting from installation CD.

2. Ifyou are installing FreeBSD 5.0 or earlier versions, skip this step. When the
“Welcome to FreeBSD” screen appears, select “6”.

3. When the “Hit [enter] to boot immediately or any other key for command

prompt” screen appears, press the SPACE key to stop the loader from

autobooting.

BTX loader 1.00 BTX version is 1.01
Console: internal video/keyboard

BIOS driver A: is diskO
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BIOS driver B: is diskl
BIOS driver C: is disk2

BIOS 636kB/74512kB available memory

FreeBSD/i386 bootstrap loader, Revision 0.8

(mailto:jkhenarf.osd.bsdi.com, Sat Apr 21 08:46:19 GMT
2001)

Hit [Enter] to boot immediately, or any other key for

command prompt.

Booting [kernel] in 9 seconds..

<-press SPACE key
A prompted label “ok” will appear at the bottom of the screen.

Insert the RocketRAID 1740 driver diskette into floppy drive. Type in “load
diskx:rr1740-x.x” (without quotation marks), and then press ENTER.

for FreeBSD 4.3-RELEASE
ok load kernel

ok load diskl:rrl740-4.3.ko

for FreeBSD 4.4-RELEASE
ok load kernel

ok load diskl:rrl740-4.4.ko

for FreeBSD 4.5-RELEASE

ok load diskl:rrl740-4.5.ko

for FreeBSD 4.6.2-RELEASE
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ok load diskl:rrl740-4.6.2.ko

for FreeBSD 4.7-RELEASE

ok load diskl:rrl740-4.7.ko

for FreeBSD 4.8-RELEASE

ok load diskl:rrl740-4.8.ko

for FreeBSD 4.9-RELEASE

ok load diskl:rrl740-4.9.ko

for FreeBSD 4.10-RELEASE

ok load diskl:rrl1l740-4.10.ko

for FreeBSD 4.11-RELEASE

ok load diskl:rrl740-4.11.ko

for FreeBSD 5.0-RELEASE

ok load diskO:rrl740-5.0.ko

for FreeBSD 5.1-RELEASE

ok load disk0O:rrl740-5.1.ko

for FreeBSD 5.2.1-RELEASE

ok load disk0:rrl740-5.2.1.ko
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for FreeBSD 5.3-RELEASE

ok load disk0:rrl740-5.3.ko

for FreeBSD 5.4-RELEASE

ok load diskO:rrl740-5.4.ko

for FreeBSD 5.3-AMD64-RELEASE

ok load diskO:rrl740-5.3-amdé64.ko

for FreeBSD 5.4-AMD64-RELEASE

ok load disk0O:rrl740-5.4-amdé64.ko

After the driver has been loaded, remove the floppy diskette from the floppy
drive.
Type in “boot” and continue with installation as normal. Refer to FreeBSD

installation guide for additional information.

ok boot

Note: On some systems, when ACPI is enabled, FreeBSD may not function
properly. Try disabling ACPI in the motherboard’s BIOS settings, or type the
command “set hint.acpi.0.disabled="1"" under the boot prompt, in order to solve
the problem.

Before exiting installation, an additional step must be taken to copy the
RocketRAID 1740 driver module to the system. On the driver diskette, there is a
setup script labeled “postinstall”, which will complete this task. Before rebooting
the system, press Alt-F4 to enter the command shell, and type the following

commands:

# mount -o ro /dev/£fd0 /mnt

# sh /mnt/postinstall
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# umount /mnt

Then, press Alt-F1 to return to the setup screen, and choose [X Exit Install] to
finish setup.

2 - Installing the RocketRAID 1740 Driver on an Existing System

If you are currently running FreeBSD and would like to access drives or arrays
attached to the RocketRAID 1740 Controller, follow the steps outlined below:

Step 1 Copy the Driver Module
If you have made FreeBSD drivers into a diskette, you can insert the driver diskette to
floppy drive, then using the following commands to copy the driver module:

For FreeBSD 4.Xx:

# mount -o ro /dev/£d40 /mnt

# cp /mnt/rrl740-xxx.ko /modules/rrl740.ko

# umount /mnt

For FreeBSD 5.x:
# mount -o ro /dev/£fd0 /mnt
# cp /mnt/rrl740-xxx.ko /boot/kernel/rrl740.ko

# umount /mnt

Alternately, it is possible extract the files from the .img files directly, without using a
floppy diskette:

For FreeBSD 4.Xx:
# vnconfig vnOc freebsd xxx.img

# mount /dev/vnOc /mnt
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# cp /mnt/rrl740-xxx.ko /modules/rrl740.ko

# vnconfig -du vnOc myfilesystem mount=/mnt

For FreeBSD 5.x:

# mdconfig -a -t vnode -f freebsd 5.x.img -u 0
# mount /dev/md0 /mnt

# cp /mnt/rrl740-xxx.ko /boot/kernel/rrl740.ko
# umount /mnt

# mdconfig -d -u mdo0

Step 2 Test the Driver Module

Test the driver module to ensure that it works with the system, by loading it during
bootup. If the module has been loaded successfully you should see the RocketRAID
1740 banner and a display screen of the attached drives. You can now access the

drives as a SCSI device.

Note: If you have no other SCSI device, the first device is /dev/da0, then /dev/dal,

etc.).

Example:

F1 FreeBSD

Default: F1

>> FreeBSD/i386 BOOT
Default: 0:ad(0,a)/boot/loader

boot:

BTX loader 1.00 BTX version is 1.01
Console: internal video/keyboard

BIOS driver A: is diskO
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BIOS driver C: is disk2

BIOS 636kB/74512kB available memory

FreeBSD/i386 bootstrap loader, Revision 0.8

(mailto:jkhenarf.osd.bsdi.com, Sat Apr 21 08:46:19 GMT
2001)

Loading /boot/defaults/loader.conf

/kernel text=0x24fldb data=0x3007ec+0x2062c -

<- For FreeBSD 5.1 and later: select "“6” on “Welcome to

FreeBSD” screen.

Hit [Enter] to boot immediately, or any other key for

command prompt.

Booting [kernel] in 9 seconds..

<-press SPACE key

Type '?’ for a list of commands, 'help’ for more de-
tailed help.

ok load rrl740
/modules/rrl1740.ko text=0xf571 data=0x2c8+0x254

ok autoboot

Note: If you have configured a RAID 10 using 4 disks, it will be registered to system

as device /dev/da0. You can use “/stand/sysinstall” to create partitions and disklabels

(like da0Os1e) on da0. Then, create a new filesystem using “newfs /dev/da0sle”. Now

you can mount /dev/da0sle to somewhere to access it.
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Step 3 Configure System to Automatically Load the Driver

To avoid typing in “load rr1740” each time the operating system is booted, the system

must be instructed to automatically load the module during bootup. To configure the

system to automatically install the module, type in the following commands:

# echo ’'rrl1740 load="YES”’ >> /boot/defaults/loader.

conf

This command will instruct the loader to load the RocketRAID 1740 module together
with the kernel. After using this command, reboot the system. The RocketRAID 1740
module should now automatically load each time the operating system starts up.

Note: When using FreeBSD 4 x, type in the following command to configure the
system:

# mknod /dev/rr1740 ¢ 200 0

Then, check to make sure the node “/dev/rr1740;4, is present in the /dev directory.

Step 4 Configure the System to Mount Volumes at Startup
Instruct the system to automatically mount the array by modifying the file /etc/fstab.

Example: Add the following line to instruct the system to mount /dev/dalsle to

location /mnt/hpt after startup:

/dev/dalsle /mnt/hpt ufs rw 0 0

3 - Updating the Driver

To update the driver with a newer revision, simply reinstall the driver following the

steps discussed in the previous section, “Install the driver on an existing system”.
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4 - Uninstalling the Driver

The driver can only be uninstalled when the system is not booting from devices
attached to the RocketRAID 1740 controller. To uninstall, remove the line

111740 _load="YES” located in /boot/defaults/loader.conf, and then delete the driver
module /modules/rr1740.ko or /boot/kernel/rr1740.ko.
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Customer Support

If you encounter any problems while utilizing the RocketRAID 1740, or have any
questions about this or any other HighPoint product, feel free to contact our Cus-
tomer Support Department.

Troubleshooting Checklist
Before contacting our Customer Support department:

Make sure the latest BIOS, driver and RAID Software have been installed for the
RocketRAID 1740. Updates are available from our website.

Prepare a list of the computer system’s hardware and software (motherboard, CPU,

memory, other PCI devices/host adapters, operating system, applications)

Contact Information

E-mail address: support@highpoint-tech.com
Phone: 408-942-5800 (request for support)
9:00AM-6:00PM, Pacific Standard Time

Additional information about HighPoint products is available from our web site:

http://www.highpoint-tech.com




FCC Part 15 Class B Radio Frequency Interference statement

This equipment has been tested and found to comply with the limits for a Class B
digital device, pursuant to part 15 of the FCC Rules. These limits are designed to
provide reasonable protection against harmful interference in a residential installation.
This equipment generates, uses and can radiate radio frequency energy and, if not
installed and used in accordance with the instructions, may cause harmful interfer-
ence to radio communications. However, there is no guarantee that interference will
not occur in a particular installation. If this equipment does cause harmful interfer-
ence to radio or television reception, which can be determined by turning the equip-
ment off and on, the user is encouraged to try to correct the interference by one or

more of the following measures:

® Reorient or relocate the receiving antenna.

® Increase the separation between the equipment and receiver.

®  Connect the equipment into an outlet on a circuit different from that to which the
receiver is connected.

®  Consult the dealer or an experienced radio/TV technician for help.
Modifications not expressly approved by the manufacturer could void the user’s

authority to operate the equipment under FCC rules.

This device complies with part 15 of the FCC Rules. Operation is subject to the
following two conditions: (1) this device may not cause harmful interference, and (2)
this device must accept any interference received, including interference that may

cause undesired operation.

European Union Compliance Statement
This Information Technologies Equipment has been tested and found to comply

with the following European directives:

®  European Standard EN55022 (1998) Class B
®  FEuropean Standard EN55024 (1998)
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